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ВВЕДЕНИЕ 

Данное пособие представляет собой руководство по использованию про-

граммного обеспечения PHOENICS для численного решения задач механики 

сплошных сред. Настоящее пособие составлено на основе материалов пред-

ставленных на сайте компании Concentration, Heat and Momentum Limited 

(CHAM, Великобритания, www.cham.co.uk ), описывающих применение про-

граммного обеспечения PHOENICS для численного решения задач. Ориги-

нальные тексты доступны по адресу: www.cham.co.uk/documentation/tr324.pdf. 

Часто возникает необходимость в изучении различных физических про-

цессов, которые описываются с помощью математических моделей. Часто мо-

дели представляют собой системы дифференциальных уравнений в частных 

производных, выражающих законы сохранения массы, энергии, импульса и 

т.д. Как правило, исследуемые процессы описываются с помощью достаточно 

сложных систем уравнений, которые не имеют аналитического решения. По-

этому для нахождения решения применяются численные методы. Процесс по-

лучения дискретных аналогов, программирование алгоритма решения, тести-

рование компьютерных программ и визуализация результатов является доста-

точно трудоемкой процедурой, требующей высокой квалификации исследова-

теля в различных областях знаний. Наиболее перспективным подходом для ре-

шения вышеуказанных задач механики сплошных сред является использова-

ние специального программного обеспечения, например PHOENICS, которое 

позволяет с помощью удобного интерфейса построить математическую мо-

дель изучаемого процесса, ввести исходные данные, получить численные ре-

зультаты и визуализировать их. Использование PHOENICS не требует специ-

альной подготовки пользователей в области вычислительной математики, ме-

ханики жидкости и газа, программирования и т.д. Программное обеспечение 

или «среда виртуальной реальности» «PHOENICS VR Environment» состоит из 

следующих модулей: 

1. Редактор постановки задач «VR-Editor» – предназначен для постановки 

какой-либо задачи; 

http://www.cham.co.uk/
http://www.cham.co.uk/documentation/tr324.pdf
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2. Модуль решения «Earth» – предназначен для численного решения по-

ставленной задачи; 

3. Редактор визуализации «VR-Viewer» – предназначен для визуализации 

результатов расчета. 

В данном пособии приводится пример использования PHOENICS для матема-

тического моделирования течения в пространственной области, в которой рас-

положены некоторые объекты (параллелепипед и цилиндрические колонны), 

взаимодействующие с полем течения. Отдельно рассматривается неизотерми-

ческий случай. Приводятся примеры визуализации и анимации результатов 

численных расчетов для анализа полученных результатов. На Рис.1 изобра-

жена область, в которой рассматривается пример решения задачи. 

 

Рис. 1. Геометрия примера моделирования течения. 
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Пособие состоит из четырех разделов, в которых подробно описываются все 

этапы построения математической модели (выбор уравнений, граничных усло-

вий и т.д.), задание геометрических данных как для всей расчетной области, 

так и для объектов внутри нее, определение параметров для вычислительной 

процедуры решения, графическая визуализация и анимация результатов рас-

четов. Документация PHOENICS насчитывает множество подобных примеров 

решения различных задач. Они доступны по адресу – 

www.cham.co.uk/phoenics/d_polis/d_lecs/general/tuts.htm. Данные материалы 

помогут овладеть основными методами и приемами решения практически 

важных задач с помощью PHOENICS. Данное программное обеспечение мо-

жет быть использовано как в образовательных целях (подготовка студентов 

для решения широкого круга задач в их будущей деятельности с использова-

нием современных методов математического моделирования), так и в научных 

(выполнение НИР: гранты, х/д и др. виды работ на современном уровне и в 

достаточно короткие сроки). 

 

  

http://www.cham.co.uk/phoenics/d_polis/d_lecs/general/tuts.htm
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Раздел 1. Среда виртуальной реальности PHOENICS-VR 

2.1. Экран среды виртуальной реальности 

 

Как правило, программы, выполняющие сложные научные вычисления 

разрабатываются на языках программирования. При применении программ-

ного обеспечения PHOENICS, если не потребуется рассмотрения нестандарт-

ных случаев, пользователь освобожден от этого трудоемкого процесса. Для 

более удобной работы по созданию программ используется среда разработки, 

которая позволяет сформулировать нашу задачу на понятном для PHOENICS 

языке с помощью специального редактора (VR Editor - Virtual Reality Editor). 

В нашем случае нам не придется писать компьютерную программу, компили-

ровать и теcтировать ее. Вся эта процедура остается для нас за кадром и явля-

ется внутренней задачей PHOENICS. Среда виртуальной реальности вызыва-

ется нажатием на иконку PHOENICS VR на рабочем столе (Рис.2). 

 

Рис. 2. Изображение среды виртуальной реальности. 
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Рисунок 2 показывает, как будет выглядеть среда виртуальной реальности  при 

её первом активировании. При последующей активации программы на экране 

будет показана та модель, с которой пользователь работал ранее. Как видно из 

рисунка панель редактора «VR-Editor» находится справа от основного экрана. 

1.2. Подготовка для запуска первого примера 

Для того чтобы начать работу со своей первой задачей (новым случаем), 

нужно в меню нажать следующую последовательность кнопок: File → Start 

New Case → Core → Оk, как показано на рисунке ниже:  

 

 Рис. 2а. Меню «File» среды VR Editor.  

 

В итоге экран станет выглядеть как на рисунке 2. 

 

 

 

Раздел 2. Настройка задач расчета потока жидкости 

2.1. Редактор постановки задач “VR-Editor”  
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Как указывалось выше для разработки новой программы в интерфейсе 

PHOENICS имеется специальный редактор VR-Editor - редактор постановки 

задач, который предназначен для: 

• Установки размеров расчётной области; 

• Определения положения, размера и свойств объектов, которые будут 

вводиться в расчетную область; 

• Указания материала, который будет занимать область; 

• Указания входных и выходных граничных условий; 

• Задания начальных условий; 

• Выбора модели турбулентности, если того требует ситуация; 

• Задания размеров расчётной сетки; 

• Указания других параметров, влияющих на скорость сходимости проце-

дуры решения. 

Следует отметить, что некоторые данные в постановке задачи уже заданы по 

умолчанию в редакторе и, если это необходимо, то их нужно скорректировать. 

То, что появляется на экране редактора постановки задач, можно (частично) 

определить с помощью рисунка 3а, описание которого приводится ниже. 

Рассмотрим контрольную панель  редактора постановки задач “VR Edi-

tor”. 

Контрольная панель разбита на две части:  

• управление движением;  

• управление областью и объектами. 

1. Управление движением: 

Четыре пары кнопок со стрелками позволяют пользователю вращать и 

перемещать область модели куда угодно, а также  увеличивать или уменьшать 

изображение модели на экране. 
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Существуют и другие элементы управления, расположенные в двух 

верхних рядах кнопок «Object» и «Domain», которые позволяют пользова-

телю применять другие варианты просмотра, такие как сокрытие объектов или 

управление просмотром текущей сетки и т.д. 

Все кнопки панели управления движением модели обобщены на рисунке 

3а. Некоторые кнопки просмотра имеют по две функции, это зависит от того, 

какой кнопкой мыши по ним нажимать. На рисунке, функции, которые акти-

вируются нажатием левой кнопки мыши, изображены до косой черты, а функ-

ции, которые активируются нажатием правой кнопки мыши, изображены по-

сле косой черты.  

 

 

Рис. 3а. Кнопки панели ручного управления движением редактора постановки задач. 

 

 

Когда нажата кнопка управления мышью («Mouse») (активирована по умол-

чанию), мышь можно использовать для поворота экранного изображения. 

Функции управления мышью перечислены в таблице ниже: 

 

Таблица 1 

Нажатие кнопки 

мыши 

Движение 

мыши 
Эффект Эквивалентная кнопка 
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Левая 

Влево 
Посмотреть 

влево 
щёлкнуть левой кнопкой мыши     на 

клавишу 

Вправо 
Посмотреть 

вправо 
щёлкнуть левой кнопкой мыши  

на клавишу 

Вверх 
Посмотреть 

вверх 
щёлкнуть левой кнопкой мыши  

на клавишу 

Вниз 
Посмотреть 

вниз 
щёлкнуть левой кнопкой мыши  

на клавишу 

Правая 

Влево Наклон вправо щёлкнуть левой кнопкой мыши  на 

клавишу 

Вправо Наклон влево щёлкнуть левой кнопкой мыши  на 

клавишу 

Вверх Уменьшить щёлкнуть левой кнопкой мыши  на 

клавишу 

Вниз Увеличть щёлкнуть левой кнопкой мыши  на 

клавишу 

Средняя(или обе) 

Влево Двигать влево щёлкнуть правой кнопкой мыши  на 

клавишу 

Вправо Двигать вправо щёлкнуть правой кнопкой мыши  на 

клавишу 

Вверх Двигать вниз щёлкнуть правой кнопкой мыши  на 

клавишу 

Вниз Двигать вверх щёлкнуть правой кнопкой мыши  на 

клавишу 

 Shift + Левая 

Влево Вращать вправо Никакая 

Вправо Вращать влево Никакая 

Вверх Вращать вниз Никакая 

Вниз Вращать вверх Никакая 

 Shift + Правая  

Влево 
Никакой Никакая 

Вправо 
Никакой Никакая 

Вверх Сдвинуть назад щёлкнуть правой кнопкой мыши  на 

клавишу 

Вниз 
Сдвинуть впе-

рёд 
щёлкнуть правой кнопкой мыши  на 

клавишу 

Если панель управления движением закрыта, то управление мышкой 

включается автоматически.  

 Чтобы быстро увеличить изображение на экране, зажмите и удержи-

вайте клавишу Ctrl, а затем переместите мышь в сторону при нажатой левой 
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кнопке мыши. Появится красный прямоугольник. Если отжать клавишу мыши, 

то изображение моментально увеличится в несколько раз. Эту операцию 

можно отменить с помощью нажатия сочетания клавиш Ctrl + Z или клавиши 

Backspace. 

2. Управление областью и объектами кнопками “Main Controls” 

Контрольные кнопки “Main Controls” основных элементов управления обла-

стью и объектами редактора виртуальной реальности обобщены и представ-

лены на рисунке 3б. Две самые важные кнопки – «Menu» и «Object» – распо-

ложены на этой панели. 

• Кнопка «Menu» даёт пользователю доступ к диалоговому окну «Domain 

Settings», где можно выбрать размеры расчётной области, вычислитель-

ную сетку, физические свойства области течения, модель турбулентно-

сти и т.д. 

• Кнопка «Object» открывает диалоговое окно «Object Management», где 

можно выбирать новые объекты для моделирования и устанавливать 

различные параметры обьектов, включая их размеры, местоположение в 

области течения, их физмческие свойства и т.д. 

Остальные кнопки управления, которые расположены ниже кнопки “Object”, 

могут использоваться для удаления объектов, их дублирования, создания  

массивов объектов, как показано на рисунке 3б. 
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Рис. 3б. Кнопки панели управления объектами и расчетной  областью редактора поста-

новки задач. 

 

2.2. Ввод данных в редакторе постановки задач 

В данном примере будет рассматриваться расчёт полей давлений и скоро-

стидавления и скорости. Для этого необходимо указать входной и выходной 

потоки. Кроме того, в качестве преград потока течения в расчетной области 

будут использоваться два объекта: забор (fence) и три цилиндра (cylinder). 

а) как пользоваться экраном среды PHOENICS-VR, чтобы создать новый слу-

чай, описано выше в разделе II. 

Чтобы ввести необходимые общие параметры для описания области течения: 

• кликните мышью на кнопку  (или  на панели сверху). После 

чего появится диалоговое окно настройки области моделирования 

(«Domain Settings»), показанное на рисунке 4: 
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Рис. 4. Диалоговое окно настройки области моделирования. 

 

Чтобы озаглавить Вашу работу, установите курсор мыши в окошко 

«Title» и напишите там, например, «Моё первое моделирование течения» («My 

first flow simulation»). 

 Чтобы установить размеры области течения, щёлкните левой кнопкой 

мыши по кнопке «Geometry», при этом откроется окно настроек координатной 

сетки («Grid Mesh Settings»). Измените размер области («Domain Size») по оси 

Z на значение 0,5 м. (по умолчанию значение равно 1,0). См. рис. 5: 
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Рис. 5. Диалоговое окно настроек координатной сетки. 

 

Автоматическое переключение включено по умолчанию, это указыва-

ется с помощью кнопок «X-Auto», «Y- Auto» и «Z- Auto», как показано на ри-

сунке 5 выше. Каждое направление можно переключить в ручной режим пере-

ключения («Manual»), нажав на эти кнопки. 

 Автоматические настройки, как правило, будут генерировать сетку, ко-

торая является достаточной для первых расчетов, но для более окончательных 

вычислений могут потребоваться уточнения.  

Нажмите «OK», чтобы закрыть окно настроек координатной сетки 

(«Grid Mesh Settings»). 
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Для того, чтобы выбрать какие физические процессы будут моделиро-

ваться, щёлкните мышью по окну «модели» («Models»), чтобы открыть меню, 

которое показано на рисунке 6 ниже: 

 

Рис. 6. Страница моделей окна настроек области моделирования. 

 

Проверьте строку «Решение для скоростей и давления» («Solution for ve-

locities and pressure») и убедитесь, что справа стоит значение «On». 

Чтобы установить модель турбулентности,  щёлкните мышью по строке 

«Turbulence models», после чего выскочит окошко, показанное на рисунке 7: 
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Рис. 7. Страница модели турбулентности главного меню. 

 

Из предложенного списка моделей выберите «LVEL»(описание моделей тур-

булентности приведено в документации по PHOENICS). 

Нажмите «Ok». 

Нажмите «Top Menu». 

Нажмите «Ok».  

Теперь пользователь должен был вернуться на главный экран редактора 

виртуальной реальности и экран должен выглядеть так, как на рисунке 8. Если 

изображение отображается неправильно, нажмите на выпадающую стрелку 

рядом со значком  на панели инструментов вверху и затем выберите «Fit 

to window» («По размеру окна»).  
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Рис. 8. Область с установленными размерами. 

 

б) теперь создайте первый объект, который будет действовать как пре-

града в области течения 
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Чтобы создать забор поперек области течения в Y-направлении нужно: 

• щёлкнуть мышью по кнопке  (или нажать кнопку  на панели 

инструментов сверху). Откроется панель «Управления объектами» 

(«Object management»). После чего нужно выбрать следующие опции: 

Object → New → New object. Новый объект будет создан в начале об-

ласти и откроется диалоговое окно «спецификация объекта» («Object 

Specification»). На экране появится диалоговое окно, показанное на ри-

сунке 9: 

 

Рис. 9. Окошко спецификации объекта. 

 

• Измените имя («Name») B1 на Fence («забор»). 

• Затем перейдите на вкладку «Size» («Размеры») и установите следую-

щие значения: 

X: 0.1  

Y: нажмите «To end» («до конца») 
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Z: 0.25 

 

• Теперь перейдите на вкладку «Place» («Месторасположение») и устано-

вите следующие значения: 

X: 0.3  

Y: 0.0 

Z: 0.0 

• Вернитесь на вкладку «General» («Общие») и установите тип («Type») 

«Blockage» (по умолчанию). 

• Для того, чтобы указать свойства материала забора, щёлкните на кнопке 

«Attributes» затем выберите «Other Materials», затем «Solids», затем 

«OK», затем «Aluminium» и ещё раз «OK».  

• Нажмите на «OK», чтобы вернуться в диалоговое окно объекта, а затем 

на "OK", чтобы закрыть диалоговое окно объекта «Object Specification». 

Экран редактора постановки задач должен выглядеть как на рисунке 10: 

 

Рис. 10. Объект «забор». 
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в) Теперь создайте еще один объект, который будет служить в качестве до-

полнительной преграды в области течения. 

Чтобы создать преграду в виде цилиндров, сделайте следующее: 

• откройте диалоговое окно спецификации («Object Specification»): Object 

→ New → New object.  

• Измените имя («Name») на CYL.  

• Затем перейдите на вкладку «Size» («Размеры») и установите следую-

щие значения: 

X: 0.1  

Y: 0.1 

Z: нажмите «To end» («до конца») 

• Теперь перейдите на вкладку «Place» («Месторасположение») и устано-

вите следующие значения: 

X: 0.0  

Y: 0.0 

Z: 0.0 

• Перейдите на вкладку «Shape» («форма»). Напротив строки Geometry 

будет окно с надписью «Default». Нажмите на него, и откроется окно 

выбора файла, через которое проследуйте по следующему пути и выбе-

рите картинку цилиндра: PUBLIC\SHAPES\CYLINDER.JPG и нажмите 

«OK». 

• Вернитесь на вкладку «General» («Общие») и установите тип («Type») 

«Blockage» (по умолчанию). 

• Для того чтобы выбрать свойства материала цилиндра, щёлкните на 

кнопке «Attributes» затем выберите «Other Materials», затем «Solids», за-

тем «OK», затем «Aluminium» и ещё раз «OK».  

• Нажмите на «OK», чтобы вернуться в диалоговое окно объекта, а затем 

на «OK», чтобы закрыть диалоговое окно спецификации объекта 
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(«Object Specification»). Экран редактора постановки задач должен вы-

глядеть как на рисунке 11: 

 

Рис. 11. Объекты «забор» и «цилиндр». 

 

г) Далее создадим множество цилиндров. 

К только что созданному цилиндру добавим ещё два, итого будет три цилин-

дра. Чтобы достичь этого: 

• Нужно выбрать цилиндр текущим объектом. Жмём кнопку  и вы-

бираем наш цилиндр CYL.  Если его выбрать, то контуры его граней ста-

нут белого цвета, что означает, что цилиндр выбран и готов для даль-

нейшего редактирования.  

• Далее щёлкните мышью по кнопке  на панели управления объектами 

и областью (см. рис. 3б) и установите значения Dimension и Pitch как 

показано в таблице ниже: 
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Таблица 2 

Direction Dimension Pitch 

X 1 0.0 

Y 3 0.4 

Z 1 0.0 

 

Переменная Dimension(размерность, в таблице 2) – это количество повторений 

в соответствующем направлении(Direction). Pitch – это расстояние между эле-

ментами. 

• Затем кликните «OK», после чего должны появиться три цилиндра, как 

показано на рисунке 12: 

 

Рис. 12. Три цилиндрических объекта. 

 

Теперь сгруппируем три цилиндра и переместим их: 

• Выделяем мышью объекты CYL, CYL 3 и CYL_4. Делается это с помо-

щью зажатой клавиши Shift. См. рисунок 12а: 
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Рис. 12а. Сгруппированные три цилиндра. 

 

Теперь переместим сгруппированные цилиндры в новое место (см. рисунок 

3б). Для этого установите положения X = 0,60 и Y = 0,04. После чего цилиндры 

переместятся в другое место, как показано на рисунке 13: 

 

Рис. 13. Массив цилиндров перемещён на новую позицию. 
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д) Далее зададим граничные условия на левой границе обасти (там, где поток 

втекает в расчетную область). 

Чтобы задать параметры входящего потока: 

• откройте диалоговое окно спецификации объектов . Object → New → 

New object.  

• Измените имя («Name») на INLET.  

• Затем перейдите на вкладку «Size» («Размеры») и установите следую-

щие значения: 

X: 0.0  

Y: нажмите «To end» («до конца») 

Z:  нажмите «To end» («до конца») 

• Теперь перейдите на вкладку «Place» («Месторасположение») и устано-

вите следующие значения: 

X: 0.0   

Y: 0.0 

Z: 0.0 

• Вернитесь на вкладку «General» («Общие») и установите тип («Type») 

«Inlet». 

• Затем щёлкните на кнопке «Attributes» и установите скорость (velocity in 

x-direction) по оси Х = 10 м/с. 

• Нажмите на «OK», чтобы вернуться в диалоговое окно объекта, а затем 

на «OK», чтобы закрыть диалоговое окно свойств объекта. 

е) Теперь зададим граничные условия на правой границе, где поток вытекает 

из расчетной области: 

Чтобы задать параметры выходного потока будем использовать предыдущий 

объект: 

• Для начала выберите из ваших объектов объект «Inlet».  

• Теперь нажмите на кнопку  («дублировать объект или группу объек-

тов»). После чего появятся два идентичных «входных» объекта, причём 
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исходный будет спрятан за его копией (т.е. на данный момент выбрана 

копия). Нажмите на позицию X и переместите копию вправо до самого 

конца.  

• Затем переименуйте копию в «Outlet»  и установите тип «Outlet». 

• Теперь перейдите на вкладку «Place» («Месторасположение») и устано-

вите следующие значения: 

X: нажмите «To end» («до конца») 

Y: 0.0 

Z: 0.0 

• В итоге получится следующая картина (см. рисунок ниже) 

 

Рис.13а 

 

Обратите внимание на торчащую красную «шпильку» слева на объекте входа 

потока. Это индикатор направления потока. В этом случае он показывает, что 

поток входит в область слева. 
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ж) Теперь установим параметры решающей программы «Solver». 

• Нажимаем на кнопку  и выбираем «Numerics», затем переходим к 

строке «Total number of iterations» 

• Установим значение 200 (по умолчанию стоит 100) 

• Щёлкаем мышью «Top menu» и «Ok». 

з) Затем, устанавливаем измерительную точку в области течения, чтобы ис-

следовать или проверять характристики течения при  решении задачи.    

Чтобы установить параметры измерительной точки: 

• Нажмите на иконку  на панели инструментов сверху или щёлкните по 

ней самой два раза;  

• Установите для неё следующие значения: 

X=0.5  

Y=0.5 

Z=0.25 

• Измерительная точка изображена в виде красного карандаша. 

и) Проверяем сетку 

Нажмите на кнопку  на панели инструментов сверху или на панели редак-

тора постановки задач. После чего появится сетка как показано на рисунке 13б: 
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Рис. 13б. Задание сетки по умолчанию. 

2.3. Запуск примера 

Решателем задач программы PHOENICS является редактор численного 

решения задач Earth. Чтобы его запустить, нужно нажать на панели меню 

сверху: Run → Solver → Ok. 

После чего начнутся необходимые вычисления. На экране отобразятся 

два графика. Левый график показывает изменение давления и скорости в из-

мерительной точке , которая была установлена во время определения мо-

дели. Правый график показывает вариацию ошибки в процессе решения. При-

мер представлен на рисунке 14 ниже: 
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Рис. 14. Пример экрана решающего редактора. 

 

По мере того, как достигается сходимость решений, значения перемен-

ных в левом графике должны становиться постоянными. С каждым последу-

ющим числом итераций, значения ошибок, имеющиеся в правом графике 

должны неуклонно снижаться. 

Процесс решения можно прекратить в любой момент. Для этого нужно: 

нажать любую клавишу, после чего нажать на «Endjob», подождать пока 

«Solver» закончит текущую итерацию и сообщит о результате. 

2.4. Редактор визуализации “VR Viewer”  

Результаты моделирования течения могут быть просмотрены  при по-

мощи постпроцессора, который называется VR Viewer. В этом разделе приво-

дится краткая информация о возможностях просмотра редактора визуализа-

ции. 

Что редактор “VR Viewer” может делать 
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Результаты отражаются графически. Возможности постобработки: 

• Векторные диаграммы; 

• Контурные графики; 

• Изоповерхности; 

• Поверхностные контуры; 

• Линии тока; 

• Линейные графики. 

Как запустить редактор VR Viewer 

Чтобы запустить редактор визуализации, нужно выполнить следующую ком-

бинацию действий: Run → Post processor → GUI Post processor (VR Viewer). 

Когда появится диалоговое окно «File Names», щёлкнуть «OK», чтобы принять 

текущие результаты. В итоге появится следующий экран: 

 

Рис. 15. Редактор визуализации в действии. 
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Рис. 15а. Панель управления редактором визуализации. 

 

Панель управления редактором визуализации 

На первый взгляд панель управления редактором визуализации VR-Viewer 

схожа с панелью редактора постановки задач VR-Editor. Однако существую 

незначительные отличия в управлении и графических окнах. Обобщённое опи-

сание кнопок панели управления редактором визуализации представлено на 

рисунке 16 ниже: 
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Рис. 16. Кнопки панели управления редактора визуализации. 

2.5.  Просмотр результатов с помощью “VR Viewer”  

Простой пример моделирования течения закончен и теперь можно по-

смотреть результаты. Для этого нужно сделать следующее: 

1. Выберите Y-плоскость нажатием кнопки «Сечение плоскостью по 

оси Y» («Slice direction Y»).  

2. Теперь нажмите кнопку  «выбор скорости» («Select velocity»).  

3. После чего нажмите кнопку  «управление вектором» («Vector Tog-

gle») 

4. В итоге отобразятся векторы скорости на текущей плоскости. 

5. Чтобы посмотреть изобары нужно сначала отжать , а затем нажать 

на кнопку  «выбрать давление» («Select Pressure»). Теперь нажмите 

. Отобразятся контуры давления. 

6. Чтобы посмотреть изоповерхности компонент скорости, сначала нужно 

отключить . Потом нажать кнопку  «выбор скорости», а вслед за 

ней кнопку  «управление изоповерхностями» («Iso-surface toggle»). 
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Вектора скорости, давление и изоповерхность скорости показаны на рисун-

ках 17а, 17б, 17в соответственно: 

 

Рис. 17а. Вектора скорости. 
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Рис. 17б. Контур давления. 

 

Рис. 17в. Изоповерхность скорости. 
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Чтобы посмотреть распределение скоростей на поверхности среднего цилин-

дра (CYL_3) , выберите его и щёлкните по нему правой кнопкой мышки. Из 

выпадающего контекстного меню выберите «Surface contour». Затем снять вы-

деление с цилиндра. После чего должен появиться поверхностный контур ско-

рости как на рисунке 17г: 

 

Рис. 17г. Поверхностный контур скорости 

 

Чтобы отобразить «трубку» линий тока, нужно выбрать X-плоскость, т.е. 

нажать кнопку «Срез по оси Х» («Slice direction Х»). Затем передвиньте 

пробу по оси Х на значение равное X = 0.095. Теперь нажмите на кнопку 

, после чего откроется окно «Streamline Management». В разделе «Streamline 

start» поставьте галочку на «Around a circle». После появится небольшой кру-

жок из сфер вокруг измерительной точки . 
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Рис. 17д. Окно опций для линий тока. 

 

Нажмите на кнопку «ОК», чтобы закрыть диалоговое окно. Теперь выберите 

пункт меню Object →New (в диалоговом окне Streamline Management). В итоге 

должна получиться следующая картина (Рис.17е):  
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Рис. 17е. Линии тока. 

 

Чтобы вернуться позднее к окну с опциями линий тока, нужно нажать  

кнопку  и после чего Object → Options.  

Чтобы получить линейный график переменной,  нажмите на кнопку  («Plot 

Variable Profile») на панели инструментов. Откроется окошко настроек гра-

фика «Graph Options». Впишите туда следующие данные:  

• Start Point: 0.0; 0.35; 0.4; 

• End Point: 1.0; 0.35; 0.4. 
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Рис. 17ж. Окно настроек графика. 

 

Когда все данные введены, нажмите кнопку «Plot», и график переменной по 

выбранной линии появится, как это изображено на рисунке 17з: 
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Рис. 17з. График давления вдоль выделенной линии. 

После окончания работы с данным примером необходимо сохранить все 

соответствующие рабочие файлы как “случай” путем нажатия кнопок: “file” и 

“Save as a case” и используя разумное имя “случая”, т.е. группы рабочих фай-

лов. 

 

Раздел 3. Пример численного расчета неизотермического течения 

3.1. Ввод данных теплопередачи при помощи “VR Editor” 

 

Для того чтобы активировать расчет температурного поля в области те-

чения должны быть выполнены следующие действия: 

• Выйти из редактора визуализации (VR-Viewer) и включить редактор 
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     постановки задач (VR-Editor) путем нажатия кнопки “Run” и затем 

     “Pre processor” и  “VR Editor” 

• Нажать  

• Выбрать «Models» → «Energy Equation» → «Temperature» и нажать ”OK” 

• Выбрать «Properties» → «The current domain material is» → «Gases» → 

«Air using Ideal Gas Law, STP» → «Ok». Затем убедиться, что в подменю 

«Properties», после строки «Initialise from ambient» стоит «On». 

• Выбрать «Initialisation». Там, где находится строка «FIINIT Value», 

нужно убедиться, что переменные P1 и TEM1 имеют значение 

«AMBIENT» и выделены серым. 

• Нажать «Top Menu» → «OK» 

 

Теперь модель готова для расчета температуры в области течения. Тем не ме-

нее, источник тепла должен быть введен в расчетной области. Для этого: 

• Щёлкните дважды по входному объекту (левая стенка) и в разделе 

«Attributes» установите значение температуры на «Ambient» (20ºС будет 

выделено серым цветом). Также уменьшите значение скорости по оси Х 

(velocity in the x-direction) с 10 м/с до 0.1 м/с. Закройте диалоговое окно 

нажатием “OK” и “OK”. 

• Щёлкните дважды по выходному объекту (правая стенка) и в разделе 

«Attributes» установите значение температуры окружающей среды 

(«External temperature») на «Ambient» (20ºС будет выделено серым цве-

том). Закройте диалоговое окно нажатием “OK” и “OK”. 

• Щёлкните дважды по объекту забор («Fence») и в разделе «Attributes» 

выберите Energy source нажатием Fixed Heat Flux → ОK. Значение в 

окошке «Value» поставьте равным 500. Закройте диалоговое окно. Забор 

должен окраситься в красный цвет. 

Данные. Теперь можно провести решение. Для этого: 

• Нажимаем Run → Solver → OK 
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• Ждём завершения расчета. 

•  

3.2. Просмотр результатов при помощи “VR Viewer”  

Редактор визуализации VR Viewer теперь можно использовать, как и раньше, 

для отображения результатов. На рисунке 20 показан контурный график тем-

пературного поля. 

 

Рис. 20. Пример температурного поля. 

 

В данном случае, объект «забор» скрывает температурное поле внутри себя. 

Чтобы сделать температуру видимой, щёлкните по забору, чтобы его вы-

брать. Затем нажмите на него правой кнопкой мыши и из выпадающего кон-

текстного меню выберите опцию «скрыть объект» («Hide object»). Также 
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можно нажать на кнопку  («Wireframe Toggle»), чтобы отобразить каркасы 

всех имеющихся объектов. Результат показан на рисунке 21: 

Рис. 21. Пример температур в каркасной модели. 

 

Раздел 4. Изменение расчётной сетки в VR Editor 

4.1. Ввод данных в редакторе постановки задач 

В этом разделе будет рассмотрен пример, в котором распределение рас-

чётной сетки будет изменяться по осям X иY. После запуска редактора поста-

новки задач VR Editor нажмите кнопку  «сетка» («Mesh toggle»), чтобы 

увидеть следующее: 
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Оранжевые линии делят направление по оси Х на 5 областей, а по оси Y 

на 6 областей (см. рисунок 22). Голубые линии – оставшиеся линии расчетной  

сетки. 

По умолчанию расчетная сетка равномерна в каждой из 5 областей. 

Сетка отображается в позиции измерительной точки  (в этом случае при Z = 

0,5 м), в плоскости, которая расположена перпендикулярно направлению про-

смотра. 

 

Рис. 22. Изображение областей расчетной сетки. 

 

Теперь изменим значения сетки. По оси Y автоматические установки будут 

удвоены. По оси X будем вручную регулировать значения, вручную, идущие 

от левой части изображения вправо, в положительном направлении оси Х сле-

дующим образом: 

• Область 1 – от большего к меньшему по экспоненте 

• Область 2 – симметрично       

• Область 3 – симметрично       
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• Область 4 – с постоянным шагом       

• Область 5 – от меньшего к большему при помощи геометрической про-

грессии. 

Для достижения разных размеров ячеек сетки потребуется выполнить следу-

ющее: 

• Запустим меню , затем выберем «Geometry», чтобы открыть окно 

настроек расчетной  сетки: 

 

Рис. 23. Диалоговое окно настроек расчетной сетки. 

 

• Нажмите на «Х-Auto», чтобы автоматические настройки сделать руч-

ными, т.е «Х-Manual». 

• Перейдите к строке «Edit All Regions in…» («Настроить все области по 

оси…») и выберите «X direction». Появится следующее диалоговое окно. 
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• Измените настройки для каждой области, так как показано на рисунке 

23б ниже: 

 

 

Рис. 23а. Настройки значений сетки по оси Х. 
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Рис. 23б. Изменённые настройки сетки по оси Х. 

• Нажмите «ОK». 

• Перейдите к строке «Edit All Regions in…» («Настроить все области по 

оси…») и выберите «Y direction». Появится следующее диалоговое окно: 
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Рис. 23в. Настройки значений сетки по оси Y. 

 

• Измените значение «Max cell factor» с 0.05 на 0.025 и нажмите «Аpply». 

Самая большая ячейка теперь будет составлять 0.025 размера области,  

что соответствует примерно 40 ячейкам, в отличие от первоначального 

размера сетки (около 20 ячеек).  Нажмите «OK», чтобы закрыть диало-

говое окно, затем ещё раз «OK», чтобы закрыть окно настроек расчетной 

сетки.  Результат показан на рисунке 24 ниже: 
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Рис. 24. Изображение координатной сетки с изменёнными значениями по оси X и Y. 

 

Всё готово, чтобы запустить редактор решения Earth. Жмём Run → Solver. 

После завершения расчета необходимо проанализировать результаты, исполь-

зуя VR Viewer, и сравнить их с результатами второго примера. Это   

позволит оценить влияние расчетной сетки на результаты.  

 

Заключение  

После завершения  работы над заданиями из данного пособия рекоменду-

ется  продолжить изучение  программного обеспечения PHOENICS, используя 

средства информационной системы POLIS. Она содержит подробные лекции, 

семинары и энциклопедию. Доступ к POLIS имеется на интернете по адресу 

www.cham.co.uk/phoenics/d_polis/polis.htm. 

http://www.cham.co.uk/phoenics/d_polis/polis.htm
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